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Dynamic Visualization Tools for Multivariable Calculus 
 
CalcPlot3D - A Guided Tour: 
 
   
 I. Graphing objects in CalcPlot3D 

 Rotating the 3D Graph    (p. 1) 
 Using 3D Glasses - Other 3D Viewing Modes 
 Using the 2D Trace Plane   (p. 2) 
 Contour Plots    
 Graphing Functions of Two Variables 

 Rectangular Coordinates (p. 3) 
 Cylindrical Coordinates  
 Spherical Coordinates  (p. 4) 

 Using Parameters  (p. 4) 
 

 
II.  Exploring Other Features & Concepts 
 Modifying color scheme of surfaces for increasing contrast between multiple surfaces 

graphed at the same time 
 Taylor Polynomials       (p. 10) 
 Lagrange Multiplier Optimization     (p. 11) 
 Coloring a Surface using a Function of Three Variables, f (x, y, z) (p. 12) 
 Graphing Complex Functions over the Complex Plane  (p. 12) 
 Graphing Implicit Surfaces (Implicit Equations in 3 variables) (p. 13) 
 More Parameters Examples      (p. 14) 
 Creating an STL file for use with a 3D Printer   (p. 15) 

 
I.  First let’s cover some of the basic functionality of the applet. 
 
Rotating the 3D graph: 
1.  Click on the 3D plot window and drag the mouse on the plot.  This should rotate the surface in the 
direction you move the mouse about the focus point (the origin, by default).  To reset the viewpoint to the 
original one, press the Home key (or choose Reset 3D View from the View Settings menu). 
 
Using 3D Glasses - Other 3D Viewing Modes 
2.  There are a variety of 3D viewing modes you can experiment with in CalcPlot3D.  These are found in 
the Select 3D View submenu of the View Settings menu in CalcPlot3D.  The standard view will always 
work, but sometimes it is fun to experience the 3D graphs with more realistic 3D depth.  If you have 3D 
glasses, there are a number of options (called Anaglyphs) you can try.  Red-Cyan or Red-Blue 3D 
glasses can be used for all Anaglyphs but the Amber-Blue Anaglyph option.  This one can only be 
viewed with Amber-Blue 3D glasses (distributed recently for the Super Bowl 2009 half-time special).  
Red-Green 3D glasses can be used for the Red-Green Anaglyph option.  The other two 3D viewing 
options (Stereo Pair and Cross-eyed) do not require 3D glasses, but do take some practice.  The biggest 
benefit of these two modes is that you get a full color 3D experience without needing 3D glasses, but it is 
harder to share this view with a class full of students who may not have mastered one of these techniques 
yet.  For more information on these modes see the 3D View Help on the Select 3D View submenu. 
 

Contact info: Paul Seeburger 
Monroe Community College 

 
pseeburger@monroecc.edu 
http://web.monroecc.edu/calcNSF/ 

 Graphing Space Curves  (p. 4) 
 Graphing Points & Vectors (p. 6) 
 Graphing Vector Fields 
 Showing Gradient Vectors on Contour 

Plots    (p. 7) 
 Graphing Regions  (p. 8) 
 Graphing Parametric Surfaces (p. 9) 
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Using the 2D Trace Plane: 
3.  Click on the 2D trace plane on the left side of the applet and drag the cursor around this place.  A trace 
point should appear on the 3D plot and move around the surface corresponding to the input point (x, y) 
that you specify in the trace plane. 
 
4.  Choose Show the tangent plane at point on the drop-down menu just above the trace plane.  Then 
click and drag on the trace plane.  You should see a tangent plane move around on the 3D surface. 
 
5.  Once the trace plot has the focus (by clicking on it), you can use the arrow keys to move the trace point 
left and right, or up and down.  You can also choose to use scrollbars to move the point in the x- or y-
direction only.  This option can be found on the Trace Plot menu at the top of the applet.  In most modes 
you can also right-click on the trace plot to see this option also. 
 
6.  Now hide the tangent plane (and the trace point) by selecting Show graphs only on the drop-down 
menu above the trace plane.  As you can see, there are more options on this menu to experiment with 
later.  You can also enter a trace point’s coordinates (or a direction vector for the directional derivative 
option) using the Trace Menu.  Click on the Graph button to reset the 3D view. 
 
 
Contour Plots: 
7.  Select the Draw Contour Plot menu option from the Contour Plot menu at the top of the applet.  
This will open up a new dialog box that looks like this: 
 
Note that you can select which function to 
create the contour plot for. You can also 
choose the first level value, the step size, 
and the number of contours to create.  This 
will create the contour plot using equally 
spaced contours.  If you prefer, you can 
also create your own list of level values 
using the Enter List button.  The list of 
level values is shown along the bottom of 
the dialog box. 
 
Let’s create a contour plot for function 1.  Change the First Level to -1.2 and the Number of contours to 
13.  Then click on the OK button.  Immediately the contour plot should begin to be drawn. 
 
8.  Once the contour plot is drawn, follow the instructions given above the 3D plot and click anywhere on 
the contour plot.  This will cause the 3D surface to be redrawn with the contour plot shown with it in 3D.  
(Note that this assumes you had the surface corresponding to Function 1 graphed before creating the 
contour plot.  If not, you will get the 3D version of the contour plot alone or with some other surface 
which was plotted before the contour plot was created). 
 
To make this easier to see, note that the surface is automatically drawn without the wireframe edges and 
using a semitransparent mode, letting us see through the surface to see the contours more clearly.  To 
show the edges again, you can select Show Edges on Surface from the View Settings menu at the top of 
the applet (or you can simply hit the E key to turn edges back on or off again).  
 
9.  Use the Reset Applet menu option on the Graph menu at the top of the applet.  This should reset the 
applet to its original configuration. 
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Graphing Functions of Two Variables: 
10. Now let’s try some other functions of two variables.  To graph other functions, you can either select a 
function from the drop-down list or you can enter your own function in the function textbox.  Examples of 
most of the supported functions are in the list, but some additional functions are supported, including the 
hyperbolic trig functions. 
 
11.  Try graphing the function,  z  =  arcsin(x + y).  Notice that it appears to be a narrow ribbon.  Press 
Control-Home.  This changes the viewpoint so that you are seeing the surface from above the xy-plane 
(from the positive z-axis).  Now press the P key (or choose Change to Parallel Projection from the View 
Settings menu).  This takes away the 3D perspective and allows you to look at the approximate natural 
domain of this function of two variables.  As you can see, this domain is clearly the region between the 
lines y = -x – 1  and  y = -x + 1. 
 
12.  Now turn Perspective Projection back on (either press the P key again or use the menu option). Then 
try the function,   z  =  1/(y - x^2).  As you can see from this function, CalcPlot3D does a decent job at 
correctly graphing discontinuous surfaces.  There are still some exceptions, but it handles most common 
types of discontinuity.  Try some other discontinuous functions to see what its limits are.  Another nice 
example of a discontinuous surface in the function list is:  z = (2x - y^2)/(2x^2 + y).  For either one of 
these, try viewing the natural domain as you did in step 11.  Note that it appears that more is missing than 
you might expect.  This is because of the min and max z cutoff values.  Open the Format Axes dialog by 
either typing the A key or choosing the Format Axes option on the View Settings menu.  Now change 
the zClip-bot value to -40 and the zClip-top value to 40 (-20 and 20 work almost as well).  These two 
values determine the bottom and top z-levels at which to “clip” the surface for clearer viewing.  Changing 
these values to -40 and 40 will fill in more defined points and show the missing parabola from each 
function’s domain more clearly.  When you are ready to continue, change the two zClip values back to 
what they were originally or simply re-enter one of the other window values and they will be 
automatically reset to the appropriate default values. 
 
For each of the four functions of two variables, there are two ways to change the type of function to 
graph.  You can either right-click on the “z =” in front of the function or you can select Set Function 
Type with the function number from the View Settings menu.  Options include:  z = f (x, y),  y = f (x, z),  
or  x = f (y, z) for functions in Rectangular Coordinates,  r = f (θ, z)  for functions in Cylindrical 
Coordinates, and  ρ = f (θ, φ)  for functions in Spherical Coordinates. 
 
Graphing Functions in Cylindrical Coordinates: 
13.  Select the Cylindrical Coordinate type,  r = f (θ, z) for Function 1.  Initially the default function is  r  
=  2, which graphs a cylinder of radius 2.  Now select a couple of different options from the drop-down 
menu.  These are updated to reflect the function type selected.    For example, select the function, r = 
sqrt(z).  This creates a particularly nice looking graph of the paraboloid, z  = x2  +  y2. 
 
When one of the four main functions is 
cylindrical, the Cylindrical Function 
Parameter dialog is displayed.  You 
can set different ranges of θ and z and number of steps to use for each cylindrical function.   You can also 
use the θ button to insert θ in your functions.  Typing theta in the function textbox will also work. 
 
Try increasing the number of steps for θ to 30 steps.  Press enter or click on the Graph button again.  
Next increase the  z  range to go from 0 to 5.  Again, to see its effect, press enter or click on the Graph 
button. 
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14.  On the Trace Plane select the first mode: Show a trace point on the surface.  Note that this now allows 
you to vary θ and z and see the location of the point on the cylindrical surface! 
 
Graphing Functions in Spherical Coordinates: 
15.  Now select the Spherical Coordinate function type,  ρ = f (θ, φ),  for function 1.  Similar to the 
cylindrical option above, the default function is ρ = 2.  This time we get a sphere of radius 2.  Try 
selecting a few of the functions from the Function 1 drop-down menu.  For example,  ρ = θ*cos(φ)/2 
produces an interesting shell-like surface. 
 
As with the cylindrical option above, there is a Spherical Function Parameter dialog that displays when 
at least one of the four functions is spherical.  As before, you can vary the range and number of steps for 
the two variables,  θ  and  φ.  Also as before, you can use the θ button or the φ button to insert θ or φ into 
your functions.  Typing theta or phi in the function textbox also works. 
 
Using Parameters:   
16.  a. Type the following functions into the Function 1 and Function 2 textboxes without pressing enter 
or updating the graph in between:   z  =  sqrt(1 – x^2 + y^2)  and  z  =  -sqrt(1 – x^2 + y^2).  Be sure both 
functions are selected using the checkboxes next to them.  Then click on the Graph button or press enter 
from one of the textboxes.  You should see a hyperboloid of one sheet (assuming you have the default 
zoom of -2 to 2 on the x- and y-axes).  This is a level surface of the function, f (x, y, z)  =  x2 – y2 + z2, 
with   x2 – y2 + z2  =  C  and  C  =  1. 
 
b.  Next edit the two functions (again without pressing enter or updating the graph in between), replacing 
the 1 with the letter C.  Once both are in place, press enter or click on the Graph button.   
 
You will see a new dialog window appear titled Adjust Parameters.  Use the scrollbar to the left of c = 1 
to vary the value of this parameter and watch the hyperboloid morph through various level surfaces. 
 
c.  Deselect the checkbox next to a = 1 and select the checkbox next to the c = 1.  Now click on the 
Animate Parameters button.  You will see the value of the parameter C is automatically varied through its 
range of values forward and then backward until you click on the same button again (now labeled, Stop 
Animation).  You can vary the speed by either entering a number larger than 1 or by using the up/down 
arrow keys or the plus/minus keys while the parameter is being animated. 
 
You can use up to four constant parameters (a, b, c, and d) in functions of two variables, implicit surfaces, 
parametric surfaces, space curves, or vector fields.  Experiment with them and let 
me know what uses you find for this feature.  It allows us to ask a lot more 
“what-if” questions! 
 
Graphing Space Curves: 
17.  Before we graph a space curve, let’s use the Reset Applet menu option on 
the Graph menu at the top of the applet to reset the applet to its original 
configuration.  Then use the Delete key or choose Clear All Graphs from the 
Graph menu to clear the graphs. 
 
18.  Now choose Add a Space Curve from the Graph menu.  Click on the 
Graph button at the bottom of the Space Curve dialog (shown on the right).  A 
multicolored helix should appear on the 3D plot.  The color variation along the 
curve is meant to help viewers see the curve’s 3D features, but space curves also 
really benefit from the other 3D modes.  Try using whichever of the 3D modes 



© 2012 Paul Seeburger -  Dynamic Visualization Tools for Multivariable Calculus (NSF – DUE – CCLI #0736968)                         5 

was easiest to view when we experimented with them earlier.  Note that you can choose to select Use 
Constant Primary Color just above the Graph button on the Space Curve dialog, if you would like to 
see the curve in a constant color like red.  Constant color is still the default for 2D curves, although you 
can select other color modes for these curves as well. 
 
19.  Click on the Animate button.  This should cause a blue vector to appear which traces out the space 

curve.  This is the vector given by the vector-valued function,   ˆ ˆ ˆ( ) ( ) ( ) ( )t x t y t z t  r i j k


. 
 
20.  Next select the View menu at the top of the Space Curve dialog.  Note that you can also select to 
show the velocity and/or acceleration vectors at the point in space, assuming the original vector-valued 
function stated above is a position function.  Select both of these so that all three vectors will be shown 
and then click on the Animate button again.  As the curve is traced out, notice the velocity vector (tangent 
to the curve in the direction of motion) and the acceleration vector (in this case always pointing toward 
the z-axis in the center of the helix. 
 
21.  Now select the first choice on the Examples menu at the top of the dialog.  It is called Coil Ring. 
Then click on the Graph button.  You should see a circular coil.  Use the View menu to deselect the 
velocity and acceleration vectors and to select the TNB-frame with all features (the TNB labels, and the 
three associated planes).  Click on the Animate button again (or use the scrollbar just below it) and watch 
how the TNB-frame varies as you move along this curve. 
 
22.  Select the Spirograph option on the Examples menu.  Note that z  =  0.  Note also that the checkbox 
is selected next to Restrict view to 2D just above the Graph button on the Space Curve dialog.  This 
option allows you to explore plane curves in a more focused, easier to see way.  As its name implies, this 
curve reminds me of something created with Spirograph (a pattern drawing “game” from when I was a 
child).  Deselect the options we selected above and select the Osculating Circle and the Curvature 
value.  Use the scrollbar to vary the position of the point along the curve and observe how the osculating 
circle and the curvature value vary.  Note what happens at the sharp turns! 
 
When you are finished with the 2D plane curve above, be sure to deselect Restrict view to 2D.  Also 
clear the graph by either choosing Clear All Graphs from the Graph menu or pressing the Delete key. 
 
23.  Here is a hands-on visual homework check I have my students do as part of one of their graded 
assignments.  Try it out! 
 

a.  Determine the line of intersection of these two planes.  Write the parametric equations for this line, 
showing all work. 2x  +  y  –  2z  =  5 & 3x  –  6y  –  2z  =  15 

 
b. Use the CalcPlot3D applet to display these two planes.  You will have to solve each planar equation for z.  

Zoom out a couple times until you can see both planes along with their intersection.  Now also show the 
line of intersection. (To do this, choose Add a Space Curve from the Graph menu, 
and enter the parametric equations for the line.)  Verify that your line is at the 
intersection of the two planes.  Rotate until you have a good view of the two planes 
and their line of intersection.  Print out your resulting figure and hand it in with this 
assignment. 

 
Answer  x =  3 + 14t           Answer line graphed with these planes: 
Line:  y = -1  +   2t   z  =  (2x  + y  –  5)/2 
  z = 15t    z  =  (3x  –  6y  –  15)/2 
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Graphing Points & Vectors: 
24.  (Graphing the plane through three non-collinear points.)  First, clear the 3D plot by either choosing 
Clear All Graphs from the Graph menu or pressing the Delete key. 
 

a. Find the equation of the plane containing the points (2, 0, 1), (-1, 2, 3), and (0, 2, -2). 
 

b. Graph this plane along with the three points to verify that all three points lie on the plane.  To do 
this, first solve the plane equation for z and graph the plane.  Then select Add a Point from the 
Graph menu, and enter the coordinates of one of the points.  Then select the size of the point to be 
4.  Repeat these steps to add the other two points.  Rotate the plot to verify that the points lie on 
the plane. 

 
Answer:  Plane equation is:  z = (22 – 10x  – 13y)/2  

 
25.  (Graphing a 2D gradient vector of a function of two variables.)  Clear the 3D plot by either choosing 
Clear All Graphs from the Graph menu or pressing the Delete key. 
 

Find the gradient vector of the function z = x2 – y2 at the point (2, -1) and graph it along with the 
surface and the point on the surface above (2, -1).  Graph this gradient vector twice.  Once with its 
initial point at the origin and again with its initial point at (2, -1, 0).  Make the first one blue and 
the second one red.   
 
To do this, first graph the surface.  Then graph the point on the surface above (2, -1).  Here this is 
the point (2, -1, 3).  Then to add the vectors, use the Add a Vector option on the Graph menu.  
Enter the vector <4, 2, 0> in the top textbox.  Next to initial point, first enter the origin (if it is not 
already there).  Then choose the color from the palette.  Repeat this to graph the vector again, this 
time with its initial point at (2, -1, 0).  Note that this vector gives the compass direction you would 
need to move toward in order to ascend most steeply from the given point on the surface. 

 
26.  (Graphing a 3D gradient vector of a function of three variables.)  Clear the 3D plot by either choosing 
Clear All Graphs from the Graph menu or pressing the Delete key. 
 

Find the gradient vector of the function,  f (x, y, z) = x2 + y2 – z,  at the point (1, -1, 2) and graph it 
along with the level surface,  f (x, y, z)  =  0 and the point, (1, -1, 2). 
 
To do this, first graph the level surface,   z = x2 + y2.  Next graph the point (1, -1, 2) which should 
be on the surface.  Finally, graph the vector, making its initial point (1, -1, 2).  Note that the 
gradient vector is normal to the level surface at this point! 

 
 
Graphing Vector Fields: 
27.  Clear the 3D plot by either choosing Clear All Graphs from the Graph menu or pressing the Delete 
key.  Select Add a Vector Field from the Graph menu.  Click on the Graph button at the bottom of the 
Vector Field dialog.  This will create a 2D vector field (on the 3D plot) in the xy-plane.  As you can see in 
the figure below, leaving P blank allows you to graph 2D vector fields.  If we enter an expression for P, 
then the number of levels given in the z-direction is specified by the bottom textbox.  The default is set to 
4.  The default scaling option, divides all vector magnitudes by 4 to make them easier to distinguish from 
each other in the vector field plot. 
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28.  Press Control-Home to view the vector field from above the xy-plane.  (You 
may need to click on the 3D plot first.)  Then press the P key to switch to Parallel 
view.  This will give a true 2D vector field plot. 
 
29.  Experiment with the Mode options.  Rectangular Array is the default 
configuration, but Cylindrical and Spherical Arrays are also available.  Both of 
these last two modes give identical results in a 2D vector field.  They give a 
circular array of vectors rather than a rectangular array. 
 
30.  Now press P again to return to the 3D perspective mode and press Home to 
view the plot from a 3D viewpoint.  Let’s experiment with some 3D options. 
 
31.  First enter P = z.  Then click on the Graph button in the Vector Field dialog.  
Try all three modes.  My favorite 3D vector field mode is Spherical Array, 
although I generally prefer the Rectangular Array mode for 2D vector field plots.   
Try using one of the 3D Anaglyph modes with 3D glasses or the Stereo Pair mode.  In the same way that 
these 3D options enhanced the viewing of the space curves we discussed earlier, I find the 3D vector 
fields are much more impressive this way.  You may even find it helpful to set the color of the whole 
vector field to blue or some other color, even in the standard 3D mode.  By default vectors are colored 
based on their direction in three space. 
 
Viewing the gradient vector of a function of two variables with the corresponding surface and 
gradient vector field: 
32.  Clear the 3D plot by either choosing Clear All Graphs 
from the Graph menu or pressing the Delete key.   
Then graph the function,  f (x, y) = x2 + y2. 
 
33.  Now add this function’s gradient vector field to the plot. 

      Hint:  It is ˆ ˆ( , ) 2 2f x y x y  i j


.  Note that you need to 
make P blank or make just 1 layer of vectors along the z-axis in 
order to create a 2D vector field. 
 
34.  Now select the Show the gradient vector at point option 
on the drop-down menu below the trace plane on the left side of 
the applet.  Click and drag on the 2D trace plane and you will 
see the gradient vector moving around inside the gradient vector 
field, and the corresponding point on the surface.  Note that the gradient vector from the trace plane is full 
size, while the gradient vector field vectors are likely scaled (unless you have set this scale value to 1). 
 
Note that you can also press Control-Q to switch between showing the gradient trace vector at the point 
in the xy-plane and at the actual point on the surface. 
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Showing gradient vectors on contour plots: 
35.  First create a contour plot for a function of two variables like the one we just graphed above. 
 
36.  Then before you click on the contour plot, select the Show the gradient vector at point option on 
the drop-down menu below the trace plane (if it is not already selected).  Click and drag on the 2D trace 
plane and you will see the gradient vector moving around on the contour plot.  This makes it possible to 
show visually that the gradient vectors are always normal to the contours of a function of two variables. 
 
 
Graphing Regions (for visualizing double and triple integrals): 
37.  Clear the 3D plot by either choosing Clear All Graphs from the Graph menu or pressing the Delete 
key.  Also select Show graphs only from the trace plot drop-down menu. 
Then graph the function,   f (x, y)  =  2 – x2 – y2. 
 
38.  We will create the region whose volume is equal to the double 

integral:   
2

1 1
2 2

1
(2 )

x
x y dy dx


   .   See the figure to the right. 

 
Select Add a Region from the Graph menu.   
Now select Function 1 to the upper right of the Create Bounded 
Region dialog and select Show Region only (Clear Plot 1st).  As 
you can verify, the default region in the xy-plane is the one we 
desire for this example, so we will leave it alone for now.  Click on 
the Graph Region button at the bottom of the Create Bounded 
Region dialog. 
 
Note:  If you want to modify the region again (once the view is cleared), it is more efficient to deselect the 
checkbox labeled, Show Region only (Clear Plot 1st). 
 
39.  Let’s do this again to obtain the region whose volume equals the double integral:  

2

2

2 4
2 2

2 4
(1 sin( ))

x

x
x y dy dx



  
   . 

 
First graph the function,  f (x, y)  =  1  +  sin(x2 + y2). 
 
Then select Add a Region from the Graph menu, or simply edit the dialog you opened earlier. 
Modify the top function to be y =  sqrt(4 - x^2)  and the bottom function to be  y = -sqrt(4 - x^2).  You 
can either enter these by hand or select them from the respective drop-down lists.  Next change the xmin 
and xmax to -2 and 2, respectively.  Then click the Graph Region button.  This double integral can be 
integrated using polar form and the region looks like a jello from a mold. 
 
Note that you can enter the region in the xy-plane using functions of y as well.  It is also possible to add 
rectangular prisms to form an inner or outer partition of the given region in the xy-plane.  You can even 
select to use scrollbars to vary the number of subdivisions to use when creating the partition.  (It is also 
possible to use the whole xy-plane viewing region to create a Riemann partition of any rectangular 
function using the Show Riemann Prisms option on the Tools menu.) 
 
You can now select the Polar tab in the lower left section of the Create a Region dialog.  You may then 
specify any polar region in terms of r and theta.  Polar prisms can then also be displayed and varied. 
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40.  For visualizing triple integrals, we can use this Region feature to create the 3D region of integration 
for a number of triple integrals.  Eventually it will be possible to specify a lower function as well as an 
upper function in the z-direction which will give much more flexibility to this option, but for now it is 
possible to give some simple examples of this nature. 
 
 
Graphing Parametric Surfaces: 
41.  Clear the 3D plot by either choosing Clear All Graphs from the Graph menu or pressing the Delete 
key. 
 
42.  Now select Add a Parametric Surface from the Graph menu.  A dialog box will be displayed on 
the right side of the screen.  You can enter any parametric surface using this dialog and using parameters 
u and v.  Try clicking on the Graph button to see the default parametric surface.  This one looks a little 
like a fat pillow. 
 
43.  Now choose the Examples menu at the top of the dialog and explore the example surfaces shown 
there.  In particular be sure to see the Moebius Strip, the Trefoil Knot, the Big Knot, the Klein Bottle, and 
the Klein Figure 8 Surface.  The knots are particularly impressive when viewed using one of the 3D 
glasses options.  Try it out! 
 

 
 
 
II.  Exploring Other Features and Concepts 
 
Modifying color scheme of surfaces for increasing contrast between multiple surfaces graphed at 
the same time: 
When you graph two or more related surfaces at the same time, it is sometimes useful to change the color 
scheme of one or more of the surfaces to increase the contrast between them.  This can be done using the 
F1, F2, F3, and F4 keys.  These function keys change the color scheme of Function 1, Function 2, etc., 
respectively.   You can also format each surface using the Format Surfaces menu option on the View 
Settings menu. 
 
The cycle of color schemes is:  standard, wireframe, reversed color scheme, transparent, transparent with 
a colored framework 
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Taylor Polynomials of a function of two variables: 
 
This topic is something that we cover at my college as part of our objectives up to the second degree 
(quadratic) Taylor approximation of a function of two variables.  I had always wanted to generalize this 
process and see what the results would look like, and eventually I was able to implement this feature.  The 
applet will allow you to use a scrollbar to scroll through the Taylor polynomials of a function of two 
variables for any rectangular function of two variables it is given.  The applet attempts to compute up to 
the 15th degree Taylor polynomial, but may reach only a much lower degree if 
the function’s partial derivatives are fairly complex.  Let’s try it out! 
 

1. First clear the 3D plot by either choosing Clear All Graphs from the 
Graph menu or pressing the Delete key. 
 

2. Graph the function,  f (x, y)  =  Cos(x)*Sin(y).  Then zoom out to -4 to 
4 in the x and y-directions. 
 

3. Now select the View Taylor Polynomials option from the Tools menu 
at the top of the applet.  It will take a few seconds as the computer 
calculates the partial derivatives and creates the Taylor polynomials.  
This example is successfully calculated all the way up to the 15th degree polynomial.  Once it is 
ready, the original function is graphed as a wireframe and the 1st degree Taylor polynomial (the 
tangent plane) is shown.  A scrollbar appears along the bottom edge of the 3D plot.  Use this 
scrollbar to scroll through the various Taylor polynomials of this function.  Note that only odd 
degrees add new terms for this particular function.  As you increase the degree of the Taylor 
polynomial notice how the polynomial of two variables fits the original surface better and better 
around the origin until it is a fairly good approximation of the whole visible surface at the 15th 
degree. 
 

4. To better view the Taylor polynomial itself (shown in the text window just above the 3D plot), 
you can click and drag on the equation and view all terms, dragging the equation left and right.  
You can also use the Tools menu option Use Factorials in 
Taylor Polynomials to switch this property on or off.  Using 
factorials makes the form of the terms of the higher order Taylor 
polynomials easier to see, and the terms also generally take up 
less horizontal space each. 
 

5. You can also vary the center point for the Taylor expansion 
using the Tools menu option just below View Taylor 
Polynomials.  The default center point is the origin. 
 

6. Other nice functions to try centered about the origin include: 
 
 f (x, y)  =  Cos(x) - Sin(y)  
 f (x, y)  =  Sin(2x) + Cos(y) 
 f (x, y)  =  Sin(x^2 + y^2) 
 f (x, y)  =  x*e^y + 1 
 f (x, y)  =  e^(x^2 + 2x - y) 
 f (x, y)  =  arctan(x*y) 
 f (x, y)  =  arctan(x+y) 
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Visualizing Lagrange Multiplier Optimization: 
 
When trying to visualize Lagrange multiplier optimization, it is helpful to be able to see the constraint on 
the contour plot.  This is easy to do using the Add Constraint Curve submenu on the Contour Plot 
dialog.  Let’s explore this feature by illustrating the following problem: 
 
Find the relative extrema of the function,  f (x, y)  =  x2 +  2y2, subject to the constraint, x2 +  y2 = 1. 
 

1. Reset the applet by either restarting the applet or 
using the Reset Applet menu choice on the 
Graph menu. 

2. Enter the function z = x^2 + 2y^2 as Function 1.  
Graph it to see this elliptic paraboloid. 

3. Select Draw Contour Plot from the Contour 
Plot menu.  

4. Modify the parameters to start at level c = 0,  use 
0.25 as the step size, and use 17 steps. 

5. Now use the Add Constraint Curve menu to 
choose Circle centered at origin.  Click OK to 
accept the value of 1 for r2.  Note the other 
options available for creating constraint curves. 

6. Click OK again on the Contour Plot dialog to 
create the contour plot and the constraint curve. 

7. Now notice that a scrollbar has appeared at the 
bottom of the 3D plot window.  This scrollbar 
can be used to move a point along the constraint 
curve through the contour plot.  The coordinates of the point on the trace of the function f 
generated by this constraint are shown in the information panel above the 3D plot.  Note there are 
also some instructions here. 

8. By default, the gradient vectors of f and of the constraint (considered as a level curve of a function 
g(x, y)) are shown at this point as well. 

9. As you move this point along the constraint, watch to see 
how the gradient vectors become parallel whenever the 
value of f is at a relative extremum subject to the 
constraint. 

10. Now click on the contour plot itself.  This will render the 
contour plot and the trace of the constraint on the 3D 
surface plot.  Use the scollbar to move a point along this 
trace curve and watch to see where you obtain relative 
extrema.  You can still see the gradient vectors on the 
small contour plot to the left. 

11. If you want the actual constraint curve to remain visible 
in the xy-plane when you go to the 3D view, you can 
select this option on the Add Constraint Curve menu.  
Try it and then use the scrollbar to move the point in the 
3D plot again.  You should see the point on the 
constraint curve in the xy-plane as well as the 
corresponding point on the surface trace above(or below) 
this point in the domain. 
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Coloring a Surface using a function of three variables, f (x, y, z): 
 
It is possible to define the colors of the surface using a function of three variables, , f (x, y, z).  The colors 
represent values of the function at points on the surface.  These values may represent temperatures, 
densities, intersections with particular level surfaces or perhaps z-heights. 
 

1. Reset the applet by either restarting the applet or using the Reset Applet menu choice on the 
Graph menu. 

2. Next select Use a function f(x, y, z) to set all surface colors from the View Settings menu (or use 
Ctrl-w).  When asked for a function, use the default:  f (x, y, z) = z.  This colors the surface by z-
level.  Use the default blue to red coloring scheme.  When asked for a lower function value to 
associate with blue, enter -1.  Enter 1 for the upper function value to associate with red.  These 
values will depend on the visible range of the function you are viewing.  Values that are larger 
than the upper value will fade to white, while values lower than the lower value will fade to black. 

3. Now try f (x, y, z) = x^2  + y^2 + z^2.  This looks particularly nice with a series of concentric 
spheres defined using spherical coordinates.  This coloring function makes the spheres vary in 
color by level.  For the spheres, you will want to set the lower function value (blue) to 0 and the 
upper function value (red) to your highest radius. 

4. If the surface is defined using the real part of a complex function, z = f (w), then you may wish to 
define the color function in terms of w.  The default coloring function for a complex function is 
Arg(f (w)), although you can change this to any function of x, y, z or any function of w.  The 
default color scheme for this mode is to use the full spectrum color wheel and use values from –π 
to π. 

 
 
Graphing Complex Functions over the Complex Plane: 
 
You can graph complex functions in the form, z = f (w), over the complex plane.  By default the real part 
is assigned to the z coordinate, but you can choose to graph the imaginary part by using the Im function, 
e.g.,  z =  Im(w3).  You can also use the Arg or the Abs function to assign a real value to the z coordinate. 
 

1.  To be able to enter a complex function, you can either right-click on the “z=” to the left of 
Function 1 and select this type of function from the list of options, or you can use the Function 
Type submenu on the View Settings menu to do this. 

2. The default function is z = |w – d|, where w is the imaginary variable varying across the complex 
plane and d is a complex parameter, which we can vary.  There are currently four available 
complex parameters for use in these functions:  a, b, c, and d.  They appear on the complex Trace 
Plot in the lower left corner of the applet, and they can be moved around the complex plane to 
show how this affects the corresponding surface(s).  You can also set them to particular complex 
numbers by either right-clicking on one and entering a value or by selecting this option on the 
Trace Plot menu at the top of the applet. 

3. Try dragging the complex parameter point d around on the complex trace plane.  You should see 
the cone’s vertex move around to follow this point. 

4. Now select a different complex function from the list or enter one of your own.  Experiment a 
little. 

5. Next select the function, z  =  |(w2 + 1)/(w3 – 2)|.  This gives an interesting function that can be 
thought of in terms of sinks and poles. 

6. Let’s color this surface using the Arg((w2 + 1)/(w3 – 2)).  This is the default coloring function for 
this complex function.  Let’s turn this coloring feature on by choosing this option on the View 
Settings menu.  Note you will be asked to verify that you want this coloring function, and asked a 
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few more questions.  Use the defaults this time.  They are different defaults for a complex function 
than we saw above for a regular function of two variables. 

7. Now let’s view this surface from above.  Hit Ctrl-Home, and then hit the P key to make the view 
parallel instead of perspective.  This will give us an interesting and colorful view of the behavior 
of the function around the poles and sinks.  This view can be improved by increasing the grid size 
and/or by using the gradient color mode (Ctrl-g turns this mode on/off). 

 
 
Graphing Implicit Surfaces (Implicit Equations in 3 variables): 
  
You can graph any implicit equation of the form, f (x, y, z) = c  or  f (x, y, z) = g(x, y, z).  For example, you 
can graph spheres or quadric surfaces by entering their equations directly. 
 

1. Reset the applet by either restarting the applet or using the Reset Applet menu choice on the 
Graph menu. 

2. Select Add an Implicit Surface from the Graph menu. 
3. The equation of a hyperboloid of one sheet is displayed as the default implicit surface.  Hit the 

Graph button.  You should see the hyperboloid appear in the 3D plot. 
4. You can enter any equation involving x, y, and z (Cartesian coordinates), any equation involving r, 

θ  and  z (Cylindrical coordinates), or any equation involving ρ, θ, and  φ (Spherical coordinates). 
5. Try entering a few equations in each coordinate system.  Note that you can either type the words 

rho, phi, and theta, or you can use the template buttons for these variables shown on the dialog. 
6. Now you can vary the accuracy of the plotting algorithm by moving the scrollbar.  This changes 

the number of cubes in each direction.  The higher this number, the more accurate the surface, but 
also the longer it takes to display (and the more memory it uses).  Note that you do need to keep 
this value within reasonable limits (less than 100 or so) or the applet will run out of memory. 

7. Now let’s play with the Examples menu.  There is a large collection of examples to explore.  
Select the surface labeled, Pipe Connector (Schwartz Surface).  The first part is my nickname 
for this surface.  This is a nice example of an implicit surface that goes beyond quadric surfaces. 

8. Now select the Blended 3 Cylinders.  Note that it is formed by multiplying the expressions for 
each cylinders together to a product of 1. 

9. Now select the Linked Tori.  This example shows how we can get the union of multiple surfaces.  
Just solve each equation for 0 and multiply these equations together to form a product of 0.  This 
effectively merges the various surfaces together.  Other examples of this can be found on this list, 
including Six Rings and Double Sphere (on the Test Cases menu). 

10.  Note there are also examples of implicit equations using cylindrical and spherical coordinates. 
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More Parameter Examples: 
 
As mentioned above (on page 3), you can now use value parameters a, b, c, and d in functions of two 
variables, space curves, implicit surfaces/equations, parametric surfaces, and vector fields.  Once you 
graph any of these objects using one or more of these parameters, you will see the Adjust Parameter 
dialog window appear.  Using the corresponding scrollbars or textboxes, you can vary the values of each 
parameter and watch the effect this has on the surface, curve, or vector field.  You can also use the 
Animate Parameter button to animate this morphing process like a little movie.   On page 3 above, we 
described how to use this feature to illustrate level surfaces using the function textboxes.  Here we will 
explore two more examples of using parameters.  
 
Example 1, Level Surfaces: 

1. Clear the 3D Plot using the Clear All Graphs button.  Then select Add an Implicit Surface from 
the Graph menu. 

2. Graph the given default implicit equation,  x^2 - y^2 + z^2 = 2.  This is a hyperboloid of one 
sheet.  Now change the 2 to an a (or another of the four value parameters).  Press enter or click on 
the Graph button.  The Adjust Parameters dialog should be displayed at the upper left corner of the 
screen. 

3. Using the scrollbar corresponding to the parameter you chose to use in the implicit equation, vary 
the parameter’s value and watch how the level surfaces change in real-time. 

4. Now click on the Animate Parameter button.  The level surfaces of this function of three variables 
will now be shown as a little “movie”, progressing through the specified range of values for the 
parameter first from smallest to largest and then from largest to smallest value in this range. 

5. On the Adjust Parameter dialog, click on the tab labeled Range.  You can now adjust the values of 
the range for each parameter, and specify the number of steps to use.  This will be especially 
useful in our next example. 
 

Example 2, Epicycloids/Hypocycloids 
1. Reset the applet using the Reset Applet button.  Then clear the 3D Plot using the Clear All 

Graphs button.  Select Add a Space Curve from the Graph menu. 
2. Zoom out to -8 to 8 in both x- and y-directions using the Zoom-out button. 
3. Now enter the following parametric function:  x  =  a cos(t) – cos(at), y  =  a sin(t) – sin(at), z = 0. 
4. Enter a range of 0 to 2pi for t, and select Restrict view to 2D just above the Graph button on the 

Add a Space Curve dialog.  If this has not already graphed the function, click the Graph button. 
5. The Adjust Parameters dialog should have been displayed.  (If not, use the Parameters menu 

option and select Adjust Parameters.)  Vary the value of a using the scrollbar.  Notice that when 
the value of a is a positive integer, you will see an epicycloid with a cycles (petals).  When the 
value of a is a negative integer, you will see a hypocycloid with a cycles (points). 

6. Now it would be nicest if we only showed these integer values for the parameter a.  To do this, 
select the Range tab on the Adjust Parameters dialog.  Set the values of a to range from -10 to 10 
and then enter 20 steps.  This will force a to only take on the integer values between -10 and 10, 
inclusive.  Now try the scrollbar again to see the series of epicycloids and hypocycloids displayed 
one after another. 
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Creating an STL file for use with a 3D Printer: 
 
One of the newest features of CalcPlot3D is its ability to save a surface to an STL file.  This STL file can 
then be used to print a solid 3D surface model using a 3D printer, sometimes called a rapid prototyping 
machine.  For example, here are the saddle,  z  =  x2 – y2, and the parametric surface I call the Big Knot.  

 
In order for the STL file to work well with the 3D printer, the surface must be given sufficient thickness.  
To address this issue, CalcPlot3D will automatically give the thickness you specify to a surface before 
creating the STL file.  The applet essentially creates a closed solid to represent the surface. 
 

1.  To give this feature a try, first find a surface that you would like 
to print to a 3D printer and graph it with CalcPlot3D. 

2. From the File menu, select Save Surfaces in StL File.  A dialog 
will appear like the one to the right. 

3. Enter the name you wish to give to the solid, and then enter the 
approximate size you expect to print it at and the desired 
thickness.  These will be used together with the dimensions of 
the 3D plot window to determine the approximate correct 
thickness to use with the surface to account for the scaling to be 
done in the printer application.  You may need to experiment a 
little with these values to get the thickness just right. 

4. If the surface you wish to print is already a closed 3D surface 
like a sphere or a torus, you can specify that no thickness be given to the surface before printing, 
or you can still use a thickness, depending on how you desire the printer to fill the void inside the 
closed surface.  In this case, if you choose to give the closed surface a thickness, you will need to 
choose between using the Opposite Normals direction (generally inside the closed solid), the 
Normal Direction (generally outside the closed surface), or the Half-and-Half option, which 
goes both directions half the thickness and creates two new shells with the same basic shape.   

5. The Half-and-Half option is always best for surfaces that flip orientation in the middle of a 
surface like a Möbius Strip or a Klein Bottle. 

6. Use the View Solid button to see what the surface/solid will look like before saving the STL file. 
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7. For regular surfaces given by functions of two variables like the saddle above, I prefer the z-shift 
down option since it preserves the exact shape of the surface on the bottom as well as the top of 
the printed surface.  But you need to compensate for the fact that the thickness will vary over the 
surface and be least thick where the surface is steepest in the z-direction. 

8. Once you are ready, click on the Create STL File button.  You will be asked for the file name and 
location and then the applet will create the STL file using the ASCII STL format (the binary STL 
format may become the default eventually).  A small progress bar dialog may appear to show how 
it is going.  Unless you use a very large number of polygons to make your surface smoother, you 
may not even see this progress bar, since it will be fairly fast. 

9. Once you have created the file, it may be helpful to download an STL viewer from either Marcam 
Engineering (free viewer is called VisCAM RP) or Materialise (free viewer called MiniMagics 
2.0).  I prefer the first right now.  This allows you to check the surface for thickness and for other 
possible problems before you print it. 

10. Now you should be ready to print to the 3D printer using the 3D printer’s software.  There is still 
some room to play with the surface in this software, scaling it appropriately and choosing how you 
want to fill the surface and how much support material to use.  Ask your local expert to help you 
with this step.  By the way, it can take a long time to print these surfaces.  My 6 in. x 6 in. saddle 
surface above took 13 hours to print and the 4 in. x 4 in. knot took almost 9 hours. 

 
 
 
 
 
Have fun and explore!  Please let me know what uses you find for this applet and what features or surface 
(curve) examples you would like to see added.   


